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Getting Started

& PC - Click Icon to Print MAC - Select 'File - Print'
Step 1: Type www.unitedstreaming.com in your browser.

Step 2: Enter your login name and password. Hit the “Enter” button.

existing user log in new user passcode
Forgot your usermame or password? Whatis a passcode?
USER.MAME PASSCODE

| N —

PASSWORD

" ENTER

Step 3: Search by keyword, subject area and grade level, curriculum standard, or by
“All Available Titles.” Click 'go' next to your search. You will be provided with a list
of videos to select from.

search by keyword

| 9°

Adwanced Search

or

search by subject and grade

Subject: I_New Heleases _:J
Taple: IAII ﬂ
Grade: I.ﬂ.ll j

©

ar

search by curriculum standard @
or

all available titles (%)

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved
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Search by Keyword

& PC - Click Icon to Print MAC - Select 'File - Print'

To Perform a Search by Keyword:

Step 1: Click on the 'Search' option at the top of your screen, then enter your
keyword search as shown below.

search by keyword

Soience @

Advanced Search

Step 2: Your results will be displayed according to a relevance rating.

Keyword: SCience

Relevance Rating : 85.1%

HetFiles #307: Science/Environment Applications

See how to find live radio on the Internet and learn about helper applications, called plug-ins, that extend the
capabilities of our browesers, Wisit two Met Classrooms in Canada wokking on learmin- by-daing environmental
prajects. One is daing a badorard bird watch and the other an acid rain Webquest. At Hemmingford Elementany,
zee awhole school paticipating in bird-related projects. Students in Gany Holzgang's class leamn to make
obsenrations, collect and record data, and use percent and tally sheets. They mere alse learning about
stewvardship and gaining an appreciation of the environment. They called their Badarard Bird Watch the "Cudioo's
Mest.” At Our Lady of Peace School in a suburb of Mantreal, Jerry Raobillard created a Mrebquest for his students to
help them understand the problem of acid rain. Theirtagc a local citizens group had hired them as researchers to
imvestigate acid rain. On each team, students took on the rales of chemist, ecolagist, health scientist, and
economist. Whatking within their teams, they created websites identifying the problems and made
recommendations on howe to combat this serious issue. Also see how Hawaii E-School students are finding
solutions to increase their islands' sustainability. Hawaiian high school students in Sue Boo Tan's class are
ewdluating the consequences of human activities in different island ecosystemns. This E-School course helps
students understand the importtance of building a sustainable future for their beautiful state considering its limited
resources and fragile environmental conditions.

Grade Level: Adult to Adult Run Time: 2600 @2000  United Learning

Teachers Guide

Step 3: Clicking the video title name will bring you to the clip viewing page.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Search by Subject and Grade
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& PC - Click Icon to Print MAC - Select 'File - Print'

To Perform a Search by Subject and Grade:
Step 1: Click the Search option at the top of the screen.

Step 2: The Main window will appear with the search options on the right-hand side
of the window. Simply select the subject and grade and click go.

search by subject and grade

Subject: |Chemistry j

Tapic: IAH j

Grade: IGF 10 j

o)

Step 3: All the results matching your search return and clicking on the title of a
video will display the chapters of that video.

Grade level : Gr. 10
Category: Chemistry

Chemistry Connections: Acid RBain and Kw

The topic of acid deposition leadsto a caleulation of hydronium and hydroxide ion concentrations, pH and

pOH using k. Caleulations demanstrate what happens to pH and pOH during a series of dilutions.
Grade Level: Gr. 9to Post-Secondary Run Time: 29:05 1998 United Learning

Carrelations

Teachers Guide

Chemistry Connections: Acid-Base Calculations
Quantitative aspects of acids and bases are used to deseribe theirsolutions. Warious ST5 contexts are used to
present the different caleulations involwing Ka, Kb, pH, pOH, hydroniom ian, hydroxide ion, and the

percentage of a reaction. Shows the relationship between Kiw, Ka, and Kb,
Grade Level: Gr. 9to Post-Secondary Run Time: 29:05 19958 United Learning

Carrelations

BlacklLine hiaster

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Search by Curriculum Standard
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& PC - Click Icon to Print MAC - Select 'File - Print'

To Perform a Search by Curriculum Standard:
Step 1: Click the Search option at the top of the screen.

Step 2: The Main window will appear with the search options on the right-hand side
of the window. Simply click the go button next to 'Search by Curriculum Standard'.

search by curriculum standard @

Step 3: Select your state, category and grade then click 'go.’

search by curricufum standard

State: |Texas -l
Lategary: |112. Science -

Grade: IGI’ g j
(90)

Step 4: All the correlations matching your search are displayed on the left side of
the screen. Click the 'Videos meeting this standard' link to view the clips within that
video.

Texas - 112. Science Correlations

Grade: Gr. 8
Subchapter B. M5 T12.M. Science, Grade §

Standard Mumber: 1 VWideos meeting this standard
Scientific processes. The student conducts field and laboratory investigations

using =afe, enwironmentally appropriate, and ethical practices.
A demonstrate zafe practices during field and laboratony investigations; and

Wideos meeting this standard

B make wise chaices in the use and consenvation of resources and the disposal
or recycling of materials.

Videos meeting this standard

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Video Page Options
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& PC - Click Icon to Print MAC - Select 'File - Print'

ISP Y=
The left and right arrows will enable you to easily go to the previous or next video on
your search results page. The middle button will return you to the search results

page.

Media Type Selection:

s cQ
This allows you to toggle between viewing your videos in Windows Media Player and
QuickTime formats.

Flayer Display Selection:

o Embedded o Standalone

If you have the Embedded button pressed, then your video will automatically play in
the video player on the left side of the page. When Standalone is selected, the video
file will play native in the Windows Media Player or QuickTime application.

All available titles list.

IF'Iaj,rIistS... vI

Flaylist Mlanager

Clicking the All Available Titles List will allow you to view all the available videos you
have access too. The Playlists drop down box shows you all your customized playlists
that you have created. Clicking the Playlist Manager option will open a popup where
you can manage your customizable playlists.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Streaming Video

& PC - Click Icon to Print MAC - Select 'File - Print'

Step 1: Select one of the titles that matches your search by clicking on the title.
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Electricity and Magnetism: The Magic of Magnets

This program is about magnetism and its relationship to electricity. Hans Oersted discoverad that an electric curant
running through a wire could zause 3 magnetic effect. Then in 1331, Michael Faraday conducted experiments that
showed that magnetism could cause a flow of electricity. Electromagnets and maglew trains are discussed.

Grades: Gr.5-Gr.8  Runtime: 1714 &2004  United Learning

Corelations

Elackline hasters Teachers Guides

Step 2: Select a clip or entire program to view and decide whether to stream or
download your video.

Download Instructions

Internet Explorer: Left Mouse click the "0 button. “rou will be prompted to zawve the media file. Choose the location
wou vwant the media file to be stared an your system.

Title Summarny

Blackline Masters Teachers' Guides

KEY
5

stream  download add to playlist
eﬂ E] Electiicity and Magnetism: The Magic of Magnets (17:14

eﬂ E The ABCs of Magnets: Magnetite, Poles, Attraction, and Lines of Force ms:52)
90 E What Makes Certain Materials Magnetic? o147

o ﬂ E Electromagnets pz:zz)

e ﬂ El CElectricity from Magnetism m1:4s)
eﬂ El taglev Magnetic Levitation @z:12
90 El video Quiz: The Magic of Magnets @2:12)

Streaming the Video
PC Users: Click the 's' to stream the video

Mac Users:

Click here for a complete list on how to stream and download for your
specific browser.

To Play a Video Full Screen (while streaming)

PC Users: If you have Windows Media Player 7+ and are using Internet Explorer,
click the “View Full Screen” button next to the “"Stop” button. Otherwise right click
over the playing video and select Full Screen.

Mac Users:

Windows Media Player: Once the 's' is clicked and the Windows Media Player window
is opened go to “View” then “Full Screen” or use the key command “"Command 4."
Hit the “esc” key to get out of full screen mode.

QuickTime: Currently we don't support full screen viewing while streaming in

6
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QuickTime. You can still view a downloaded clip full screen by clicking the 'Movie' link
at the top of your screen then select 'Full Screen.'

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Downloading Video PC

& PC - Click Icon to Print MAC - Select 'File - Print'

PN
@E Internet Explorer:

LEFT CLICK:
Step 1: Hover your mouse over the 'd' button and r click.

Step 2: Click "OK” then select where you would like to save the file.

Step 3: You will see a pop-up screen that asks you to save your video clip. You may
give your video a different name. Navigate to a folder to save your video.

RIGHT CLICK:
Step 1: Right click the 'd"' button.

Step 2: Select the option "Save Target As".

Step 3: You will see a pop-up screen that asks you to save your video clip. You may
give your video a different name. Navigate to a folder to save your video.

Netscape Navigator:

LEFT CLICK
Step 1: Hover your mouse over the 'd' button and left click.

Step 2: Click "OK” then select where you would like to save the file.

Step 3: You will see a pop-up screen that asks you to save your video clip. You may
give your video a different name. Navigate to a folder to save your video.

RIGHT CLICK:
Step 1: Right click the 'd"' button.

Step 2: Select the 'Save Link Target As' option.
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Step 3: You will see a pop-up screen that asks you to save your video clip. You may
give your video a different name. Navigate to a folder to save your video.

To Play a Downloaded Video
After downloading your video clip, navigate to the folder where your video clip is
located. You can view the video by double clicking on the file.

To Play a Downloaded Video Full Screen
Right click over the playing video and select Full Screen.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Downloading Video Mac

& PC - Click Icon to Print MAC - Select 'File - Print'

S

@E Internet Explorer: (Click here for a complete list on how to stream
and download for your specific browser.)

Step 1: Hold down the control key and click and hold.

Step 2: Click and scroll down the pop-up menu that appears to "Download Link to
Disk...”

Step 3: You will see a pop-up screen that asks you to save your video clip. You may
give your video a different name. Navigate to a folder to save your video. (We
suggest downloading to the desktop or creating a video folder).

Step 4: Save the file extension (.asf for Windows Media™ Files or .mov for
QuickTime™ Files).

Netscape Navigator: (Click here for a complete list on how to stream
and download for your specific browser.)

Step 1: Hold down the control key and click and hold.

Step 2: You will see a pop-up screen that asks you to save your video clip. You may
give your video a different name. Navigate to a folder to save your video. (We
suggest downloading to the desktop or creating a video folder).
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Step 3: Save the file extension (.asf for Windows Media Files or .mov for QuickTime
Files).
Finding and Playing Your Downloaded Video

Windows Media:

If the downloaded video clip looks like this: *ideaclipast

...Double click on the icon and your video will play.

If your downloaded video clip looks like this: idenclip.ast

...0pen your Windows Media Player application and then go to “File” > “Open” and
find the file. Then your video will play.

To Play a Downloaded Video
After downloading your video clip, navigate to the folder where your video clip is
located. You can view the video by double clicking on the file.

To Play a Downloaded Video Full Screen
Windows Media Player: Go to “View” then “Full Screen” or use the key command
“Command 4." Hit the “esc” key to get out of full screen mode.

QuickTime: Click the 'Movie' link at the top of your screen then select 'Full Screen.'
Hit the “esc” key to get out of full screen mode.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Mac Streaming and Downloading Specifications

& PC - Click Icon to Print MAC - Select 'File - Print'

Viewing Videos Full Screen
View Video Full Screen while streaming (excluding Netscape 4.7)
Select View > Full Screen from top menu bar.

View Video Full Screen when Downloaded (WMP)
Select View > Full Screen from top menu bar.

View Video Full Screen when Downloaded (QuickTime)
Select Movie > Full Screen from top menu bar.
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Streaming and Downloading Specifications per browser

IE 5.2 (OSX)

WMP Stream: Standalone

WMP Download: Option click to auto download to desktop or click and hold or control
click to get popup. Select the ‘Download Link to Disk' option. Then select where you
would like to save the file.

QuickTime Stream: Embedded

QuickTime Download: Option click to auto download to desktop or click and hold or
control click to get popup. Select the ‘Download Link to Disk' option. Then select
where you would like to save the file.

IE 5.0 (Classic)

WMP Stream: Standalone

WMP Download: Option click to auto download to desktop or control click to get
popup. Select the ‘Download Link to Disk' option. Then select where you would like
to save the file.

QuickTime Stream: Embedded

QuickTime Download: Option click to auto download to desktop or control click to get
popup. Select the ‘Download Link to Disk' option. Then select where you would like
to save the file.

NETSCAPE 7.0 (OSX)

WMP Stream: Is not supported.

WMP Download: Click and hold, control click or option click to get popup. Select the
'Save Link Target As' option. Then select where you would like to save the file.

QuickTime Stream: Is not supported.
QuickTime Download: Click and hold, control click or option click to get popup. Select
the 'Save Link Target As' option. Then select where you would like to save the file.

NETSCAPE 6.2 (0SX)

WMP Stream: Is not supported.

WMP Download: Click and hold or control click to get popup. Select the 'Save Link as'
option. Then select where you would like to save the file.

QuickTime Stream: Embedded
QuickTime Download: Click and hold or control click to get popup. Select the 'Save
Link as' option. Then select where you would like to save the file.

NETSCAPE 6.0 (Classic)

WMP Stream: Is not supported.

WMP Download: Click and hold or control click to get popup. Select the 'Save Link as'
option. Then select where you would like to save the file.

QuickTime Stream: Embedded

QuickTime Download: Click and hold or control click to get popup. Select the 'Save
Link as' option. Then select where you would like to save the file.

10
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NETSCAPE 4.7 (Classic)

WMP Stream: Embedded

WMP Download: Click and hold, control click or option click to get popup. Select the
'Save this Link as' option. Then select where you would like to save the file.

Cannot go full screen while streaming

QuickTime Stream: Embedded
QuickTime Download: Click and hold, control click or option click to get popup. Select
the 'Save this Link as' option. Then select where you would like to save the file.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Downloading Teachers' Guides and Blackline Masters

& CPC - Click Icon to Print MAC - Select 'File - Print'

Many unitedstreaming™ titles come with Teacher's Guides and Blackline Masters
(lessons and student activities). You will notice these links just above the video title.

BlackLine Master Teachers Guids
key: o - stream s} - download

oi-:-'i:- Age of Discovery {(1400-1550), The 223

These supplementary materials may be viewed by simply clicking on the link. You
must have Adobe Acrobat Reader to view the guides. If needed, visit
www.adobe.com to download their free “Acrobat Reader.”

Teacher’s Guide Blackline Master

11
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United Learning is a division of Discovery Communications.

Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Preferences (user created with Passcode)

& PC - Click Icon to Print

MAC - Select 'File - Print'

If you have created your account via the Passcode system then when you click the
'Preferences' tab from the top navigation you are be able to change your account
information.

Edit your login information:

12
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Username: || #

Current Fessword MNew Passwond Confirm Wew Cassword
Mew Password: | | |
Legve dlank F pou do not wish fo change pour cotvent passuond.

Security Reminder

Question: Iwhat are the last 4 digits of your social security number? ;I *

Answer: | *

Edit your contact information:
First * Last®

Mame:

Email Address:

Confirm Email Address:

Title:

Organization:

City:

State fProvince:

ZipfPostal Code:

|
|
|
|
|
Address: |
|
|
|
|
|

Country:

Ehone Fax
Phone Numbers: | |

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Preferences (user created without Passcode)

& PC - Click Icon to Print MAC - Select 'File - Print'

If you have a shared username and password then when you click the 'Preferences'
tab from the top navigation you are able to change your media delivery options.

13
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Mediz Delivery Oafiens

Closed Dovemload
Caption Link
r 03
et Cptions |

Closed Caption: Clicking this box will enable to you view the closed captioning track
of a video title (PC only). Please note that not all video titles have a closed
captioning track.

Download Link: Clicking this box will show/hide the 'd' button on the video clip
page.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Viewing Closed-Captioning

& PC - Click Icon to Print MAC - Select 'File - Print'

Many of the titles available on unitedstreaming™ may be viewed with closed-
captioning. This feature is available using Internet Explorer and only while
streaming. Closed-captioning is not currently available for Macs. If the title has
closed captions, you will notice a 'CC' above the title. To view captioning:

Step 1: On the top Navigation bar click on the text marked Streaming Options.
Check the box marked Close Caption and click on Set Options.

/) Streaming Dptions - Microsoft Internet E&g =5 ]
Stramming ootions info j

Weoia Delivery Oaffons
Embeddad Sand-zlons:  Closed Dovsmilozd
Straaming  Streaming  Caplion Link

i [ r [¥

4]

Step 2: Select the clip you wish to play and click on the button to stream. The
captioning will appear at the bottom of the player.

14
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United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Advanced Search

& PC - Click Icon to Print MAC - Select 'File - Print'

The unitedstreaming™ advanced search allows you to search and sort your content
in a variety of ways.

Step 1: Click on Advanced Search as shown below.

search by keyword

o)

Advanced Search

Step 2: The advanced search page gives you the following selection choices:

15
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Advanced Search

Keyword: I
subject: | All |
Topic: IAH TI
Grade: I.-":"x” j
Order Results By: IHE|E‘V‘E[FICE "’I i Azcanding I Descending

Feleyyance

Copyright :
Title

Step 3: Enter search criteria in one or more of the search fields as shown:

Advanced Search

Keyword: |e|eu:ti|:|n Process

Subject: |S|:u:ial Studies j

Topic: IAmerican Histary j
Grade: |Gr. 3] j

Order Results By: ICDpyrlght "I i Ascanding i* Descending

Step 4: Your results will be displayed by your choice of Relevance, Copyright, or if
your keyword is in the Title of the program:

Heyword: election process

Almost Painless Guide to the Election Process, The

Harlan and Marie are back with this indispensable guide to the electoral process. Accompanied by
contemporary and archival wvideo footage, wibrant graphics, and informative commentary, their"spin" on the
campaign trail is not to be missed. Highlights include the explanation of political paties, campaigns, and the
different types of elections. Throughout, emphasis iz placed on the involvement of citizens in each step of the

process. Designed for grades 5 - Up, this program provides a great rewview for older students as well.

Grade Level: Gr. 5 to Adult  Run Time: 21:39 @ 2000

To maximize the power of the keyword search, you can use different

boolean operators which can give you flexibility in your search. Here is a list
of the most popular:

AND
Selects documents that contain all of the search elements you specify. Documents

16
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retrieved using the AND operator are relevance-ranked. Following are examples of
search syntax.

Search Example

To select documents which contain stemmed variations of the phrase
"pharmaceutical companies" and stemmed variations of the word "stock," you can
enter the following: pharmaceutical companies AND stock. Only those documents
which contain both search elements, or stemmed variations of them (e.g.
pharmaceutical company; stocks, etc.), are retrieved and ranked according to their
score.

OR
Selects documents that show evidence of at least one of your search elements.
Documents selected using the OR operator are relevance-ranked.

Search Example

To select documents which contain stemmed variations of the word "election" or the
phrases "national elections" or "senatorial race" you can enter the following: election
OR national elections OR senatorial race. Only those documents which contain at
least one of the search elements, or a stemmed variation of at least one of them, are
retrieved and ranked according to their score.

0

Search for complete phrases by enclosing them in quotation marks. Words enclosed
in double quotes ("like this") will appear together in all results exactly as you have
entered them. Phrase searches are especially useful when searching for famous
sayings or proper names.

?

Specifies one of any alphanumeric character, as in ?an, which locates "ran,
"can," and "ban."

nmn

pan,"

*

Specifies zero or more of any alphanumeric character, as in corp*, which locates
"corporate," "corporation," "corporal," and "corpulent."”

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Calendar

& PC - Click Icon to Print MAC - Select 'File - Print'

One of the newest tools available to you is an online Calendar with commemorative
events linked to video content. As you become familiar with this useful new feature,

17
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you'll discover a variety of innovative ways to incorporate digital video into your
curriculum.

Choose any month you wish and you'll find a list of commemorative events for each
day. Each event is linked to specific video clips or full-length videos that can be
incorporated into your lesson plans. Suggested grade levels and running times are
listed as well.
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United Learning is a division of Discovery Communications.
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Quiz Center

Quiz Center User Guide Overview

& Click Icon to Print (PC Only)

The unitedstreaming Quiz Center allows you to easily:

Search for existing quizzes from our template library

Modify existing quizzes

Create new quizzes

Choose from multiple choice, short answer and true/false questions
Identify curriculum standards within the quiz

Add videos to the quiz

Share quizzes

18
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e View grade reports

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Navigating the Quiz Center

& PC - Click Icon to Print MAC - Select 'File - Print'

The default screen for Quiz Center has a navigation area on the left to easily take
you to different basic functions. To the right is the main content area, which houses
all of the Quiz Center creation screens.

GUIZ CENTER QUIZ CENTER
fly g
= Wy Quizzes (activated) @
iwil Brghts: The Long Road ta Equalty Wew Srace Report  Make Copy archiw
Srisnce: The Periadic Tabls Uiew Grage Rapork - Make Copy
' My Quizzes {In Edit Made) 2]

Mathemabics Crelete Achiwale

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

My Quizzes (activated)

& PC - Click Icon to Print MAC - Select 'File - Print'

This folder contains quizzes that can be taken at any time. Any quiz in this section
will be viewable to all students who log in to take a quiz. Next to each quiz are
options to ‘View Grade Report’, ‘Make Copy’ and ‘Archive’. The ‘View Grade Report’
option will display results of every user who took that quiz. To make a copy of a quiz,
simply click the ‘Make Copy’ option next to that quiz which makes a copy of that quiz
in the ‘My Quizzes - Edit Mode’ folder. The ‘archive’ feature will add that quiz to a
temporary archived list.

19
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' My Quizzes (In Edit Made) @ |
[Mathematics Delete  Activate |
Yiew drchived Quizzes

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

My Quizzes (in edit mode)

& PC - Click Icon to Print MAC - Select 'File - Print'

This contains quizzes in edit mode which cannot yet be taken. If you would like to
delete a quiz from this list, simply click the ‘Delete’ button next to that quiz. To add a
quiz from edit mode to activated mode, just click the ‘Activate’ option next to that
quiz and it will move in to the activated quizzes folder.

QUIZ CENTER

w M UizZes
¥ Create New Quiz
# Quiz Librar

» Search

= Wiew 0

On the left side navigation, you will see *My Quizzes’. Clicking this option will bring
you back to the default screen with all of your activated and deactivated quizzes.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Creating a new Quiz

& PC - Click Icon to Print MAC - Select 'File - Print'

Step 1: Enter Quiz General Information LddEdit

Clicking the option to “"Create a New Quiz"” on the left side navigation will bring you
to the five steps to create a new quiz. First, click the "Add/Edit" button next to to
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‘Step One: Enter Quiz General Information’. In this section, you can enter your quiz
name, class, instructions, objectives and notes.

Quiz Hame: I

Class: ISeIect Class or Enter Mew Class ;l nr'l

Quiz Instuctons:
W bis play

1l

Kl

Quiz Objectives:
V¥ ois play

1l

=

Quiz Hobes:
(Mot for Display)

1l

[

Information entered in the 'Quiz Instructions’ or ‘Quiz Objectives’ areas has the
ability to be displayed or not by clicking the checkbox below each area. Information
entered in the 'Quiz Notes’ field will not

be seen by anyone other than the teacher.

Additional Options

Which actions should be performed when a participant completes this quiz?

r Display quiz questions to participants in randorm arder
I allow patticipants to view their graded quiz (with carrect answers revealad)

[T send the participant's quiz results to you via email

"Display quiz questions to participants in random order" does exactly that,
randomizes the questions to each student taking the quiz. "Allow participants to view
their graded quiz (with correct answers revealed)" will show the students their
answer as well as the correct one. "Send the participant's quiz results to you via
email" will send you their results as opposed to logging into unitedstreaming and
looking them up manually. Click ‘Save and Continue to Step 2’ to continue.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Adding Curriculum Standards
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You may identify the state curriculum standards covered in your quiz by simply

selecting a state, category and grade. This will display all the correlations set to your
specifications.

Colorado -5-8 Civics Correlations

Stamdard Number: 1 Add Stanpdard to Quiz
Students understand the purposes of gowemment, and the basic constitutional principles™ of the United States republican

farm of gowernment,

Clicking the link "Add Standard to Quiz" will add that specific standard to your quiz.

Current Standards

1. 4M-E1 - Visualize and draw two- and three-dimensional geometric figures with  Rernove Standard
special attention to analyzing and reasoning informally about thew properties {e.g.,
parallelizrn, perpendicularity and congruence)

2. 1M-E3 - Demonstrate proficiency with the operations of multiplication and Fermoyve Standard
division of whole numbers

Add a Standard

State: |.ﬁ.lahama :J
Category: ISciEn-:E v}
Grade: IP.II ﬂ

@

If you would like to remove a standard, just click the "Remove Standard” link next to
that standard. Then click *Go to Step 3 (Videos)’ to save your selection and proceed
to the next step.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Adding Videos to a Quiz

& PC - Click Icon to Print MAC - Select 'File - Print'

In this area, you can do a keyword search to find videos you are looking for, search
by curriculum standard by the standards you have already selected in the previous
step (if any), by all available titles or by alphabetical listing
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Search by Keyword
[I:.inmes | Search by Keyword |

ar

Search by Quiz standards
I T L T —— Search by Standard

ar

All Available Titles
Subject Listing

Mew Releases Sk
Chamiztry Eany Childhaod

Eath ang Spage Sclance Haghth and Guidance
Insirugtianal Methodaology Languags A Reading

Life Soicnce/Biology bdathematies

Fhyzical Educalisn Physical Seisfee
Eractlcal Skills Sohenes Stalk:

Social Studias Shudy and Reseawch Shlls

Wooational Edusation/C e World Languages

Alphabetical Listing

Ao E-H
-1 M-P
O T [1

Once you select a video title, you can preview a clip by clicking the ‘s’ button or add
it by clicking the ‘a’ button.

HEY
0 a
straam ackl o iz

o ﬂ Mathematical Eye: Fun and Games gzo.48)

After you add a video clip to your quiz you will notice the ‘a’ button is absent from
this listing showing that you have already added it to your quiz. If you would like to
add more video clips from a different video title to your quiz, clicking "New Search"
will take you back to the default search screen.

Step 3: Select Videos for Students to Watch. (optiona

New Search vsplay Current Wideos

At the top of the screen you will also find a "Display Current Videos" link. Clicking
this link will show the videos you have associated with the quiz. If you click the video
clip link, it will display all the chapters of that video. Clicking the "Remove Video" link
will delete the video from your quiz. To continue to the next section, click the ‘Go To
Step 4 (Questions)’ button at the bottom of the page.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved
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Activating Your Quiz

& PC - Click Icon to Print MAC - Select 'File - Print'

To activate a quiz, go to the main Quiz Center page by clicking the "My Quizzes” link
on the left.

' My Quizzes {In Edit Mode) &2

i"‘l .I‘l\.'IL'l I -\..'-.iL = ._.\".'I'.'I.'.' -'"'\:L'.i' Al

Then simply click the ‘Activate’ link next to the quiz under the ‘my quizzes - in edit
mode) folder. This will make the quiz active, which means when a student logs in, he
or she will be able to see this quiz.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Activating Your Quiz

& PC - Click Icon to Print MAC - Select 'File - Print'

To activate a quiz, go to the main Quiz Center page by clicking the "My Quizzes” link
on the left.

' My Quizzes (In Edit Mode) &2

Mathematics Delate  Activate

Then simply click the ‘Activate’ link next to the quiz under the ‘my quizzes - in edit
mode) folder. This will make the quiz active, which means when a student logs in, he
or she will be able to see this quiz.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Viewing the Grade Report
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Clicking the “View Grade Report” link next to a quiz will take you to the full quiz
summary page.

Full Quiz Summary

MName Date/Time Score
9:5% AM 0572872003 Q0.0 Delete Score
Quiz Name! Ciwil Rights: The Long Road to Equality
Number of Attempts: 1
Average Grade: 20.0%

This screen displays the name, date and time the quiz was taken and the score.
Clicking the name of a student will display his or her results from the quiz. You can
also click the ‘Delete Score’ link to delete the record of that user taking the quiz.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Archiving a Quiz

& PC - Click Icon to Print MAC - Select 'File - Print'
Also available from the Quiz Center home page, is the archive quiz feature.

Jiew Archived Quizzes

This will allow you to archive quizzes when they are not being taken so when a
student logs into the Quiz Center, he or she will only see the quiz they need to take.

' My Quizzes {archived) ]

A snin Sround The S0lar Sgstenn: D Roos {EIQNDOTS Vie Malea

e Grade Report apy  Unarchive
Inner Plansats L

Yiew dctive / Edit-Mode Quizzes

When you need the quiz again, simply click the view archived quizzes link and then
click to unarchive your quiz. It's that simple.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved
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Sharing your Quiz

& PC - Click Icon to Print MAC - Select 'File - Print'

By default, you won’t have any quizzes associated to you but are able to search our
expanding database of shared quizzes. These quizzes can only be added by a user
with account administrator privileges but are available to all teachers. This option is
available from the left side navigation under the ‘Quiz Library’.

Keyward i Search

Display: p System Quirzes I‘l_" Soround Quizrzes F Department’School Quizzes

View all available Quiz Templates

Clicking ‘Search’ brings up a page to do a keyword search of our quizzes. There are
also checkboxes to limit your search to ‘System Quizzes’ ‘Account Quizzes’ and/or
‘Department/School Quizzes’. Beneath the search option on the left side is the View
All Available Quiz Templates’ link which lists all available pre-made quizzes.

Results
Juiz Duiz Mame AchHon
1 A 5pin Around the Solar System: Look To The Stars [(systems) Pravigw | Copy to My Quizzas
2 A Spin Around The Solar System: Our Rechy Meighbors: Inner Planets | Preview | Copy to My Quizzes
[system)
3 | A spin Around The Solar Sustem: The Outer Planets: Sas Giants Preview | Copy to My Quizzes
[swstem]

Clicking the ‘Preview’ button will allow you to see the quiz instructions, objectives,
standards and videos to watch. If you click the *Copy to My Quizzes’ link, a copy of
that quiz will be added to your *‘My Quizzes (in Edit Mode)’

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Sending a Quiz to Your Students

& PC - Click Icon to Print MAC - Select 'File - Print'

To view the quiz hot link, click the quiz name from the default Quiz Center screen. At
the bottom of the page is the quiz hot link which you can email to your students.
Students entering this url into their browser will take them directly to the quiz. The
quiz code is needed if part of the quiz hot link gets cut off. For example, your
students can just go to http://www.unitedstreaming.com/takeaquiz/ and then they
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will be prompted to enter in their quiz code. Upon doing this they will be able to take
their quiz.
Hot Link: Provide the following link to your students and they will be able to take this guiz.
hittp ./ fww united streaming.com/takeaguizfindex. ofm?passcodeCuiz=FAFT-B38E
Quiz Code: FAF7-B83808

{The Quiz Code s not nesded when pou use the Hot Link provided abowe.)

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Student View

& PC - Click Icon to Print MAC - Select 'File - Print'

On the left side, they see options for *‘My Quizzes’ and ‘My Grade Report’. Clicking
‘My Quizzes' takes them to the default screen for the quiz creator. Under ‘My Quizzes
- Already Taken’, students will see all quizzes they have taken. They can view their
grade report for that quiz by clicking the ‘View Grade Report’ link next to the quiz.

QUIZ CENTER GUEZ CENTER

My Grade Repod ' By Ciizzes (Already Taken)

& Spin Around The Solar System: Our Rocky Neighbors: Inner Flanets Vigw Grade Report
Civil Rights: The Lang Raad to Equality
Simply Science! The Periodic Table Wigw Srads Beport

In order bo bakee & quiz, vou must get & guiz hink from your teacher.

When they click on ‘View Grade Report’, they can view the date, time and score of
the quiz.
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Quiz Results far:

Quiz Name: A Spin Around The Solar System: Dur Rocky Neighhors: Inner Planets
Tirme Submitted:  9:43 AM on 05/26/2003

Grade: 0.0%s

KEY:

¢ Cuestion Answered Incorrectly
X Wrong Answer
|:| Answer{s) You Selected

v 1. Which of the following is not a name for the four planets closet to the sun? (Choose
anly one answer)

Terrestrial

& Earthlike

Inner Planats

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Administrator View

& PC - Click Icon to Print MAC - Select 'File - Print'

If you log in with 'Administrator' status, you will have the ability to determine which
quizzes will be available to your account. Clicking the 'View All' link from the right
navigation will display the complete listing of quizzes. Clicking the 'Make System
Template' link will enable that specific quiz to be searched by your teachers. So when
a teacher logs in, they will be able to view ONLY the quizzes that you selected as
System Templates. Also, instead of a teacher seeing 'Make System Template' they
will see a 'Copy to My Quizzes' link.
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Results
Quiz Quiz Mama Action
1 A Spin Around The Salar Syster: Asterolds, Comets, and Pluto! Freuiew
The Small Biares [spstam)
2 [A spin Around e Solar Syelenn: Luok To The Slars (syslein] Prowiew
3 | A Spin Around The Salar Spstern: Moon Dance [systerm) Preview
4 | A Spin Around The Salar Systern: Qur Raocky Meighbors: Inner Preview

Planets [system)

5 |A Spin Around The Solar Systern: The Quter Planets: Gas Giants Previaw

[systerm)
& |ASpin Around The Solar Systern: The Sun: Our Star Attraction Previaw
Isysterm)
7 | A Spin Around The Solar Sestern: There's Mo Place Like Earth Previaw
[=systerm)
2 | Abstinence By Choice: Ernctional Choices: Mot Just 2 Body Preview [ Make Systern Termnplate

[AAC_Markeling_Downluad)

2 |All About Rocks [TH_RESION 11 ESC_CARROLL ISD - Carrall Preview [ Make Systern Termnplate
Clarmartary]

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Passcode

& PC - Click Icon to Print MAC - Select 'File - Print'

Users now have the ability to create their own user accounts on the
unitedstreaming™ website!

We have developed a new feature called a "passcode.” Each passcode is a random
eight character alpha numeric string, separated by a “-" (Sample passcode: A42F-
8B3D). Passcodes are automatically assigned each time an account, department, or
user is created in the unitedstreaming site. Each District is set up as an Account in
the unitedstreaming system and each Department is generally set up as a school.

Passcodes can be viewed in the admin.unitedstreaming.com
(unitedstreaming.com/admin) website for administrators.
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ADMINISTRATOR

Account: PUBLIC SCHOOLS
Passcode: 4A42F-0B3D
[ mhat is this passcode? ]

Account Administrators:

Add Administrator

Each detail page (account detail, department detail, and user detail) now has a
section near the top where each subsequent passcode is displayed. The “account
information” page displays a passcode at the top for each account. The “department
information” page also displays a passcode at the top of each department. Lastly,
the “user information” page displays each “user passcode” near the top of the page.

There is now an option for an end-user to enter a passcode on the unitedstreaming
homepage.

e T e

What iz a passcode’

Entering a proper passcode on the homepage will allow the user to create a user
account. Different user account types will be created based on the type of passcode
a user enters on the homepage.

Once a passcode is entered, the user will be prompted to enter his/her information
and choose a username and password.
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d_,___,—_:\“\\"- F i
. umlcl:lsamammg
TN

Welcome to unitedstreaming!

Pleaze take a brief morment to complete the following form so that you
can create a user account of your very ouwn,

Once your lagin has been crested, we will autornatically lag vou inke the
unitedstrearming sita.

MOTE : Fields marked with & * are required,

First * Last ®
Bame @ ! |

Tite 1 iTI’! acher

School or Organization @ 4lcots Elem

Addrass Line 11 |
Addiess Line 21 |
citys |
State / Prowince : |Mazzachusetts =] =
Zip / Postal Code: !
tountry: |
Phone Fax
Phone Numbess @ | |
Email Addrass : | *
Confirm Email Address 1 | *

A single passcode can be used multiple times by many users. However, once an
individual user has used a passcode to create his/her own user account on the site,
he/she should no longer enter the passcode on the homepage and, instead, should
simply login to the site with his/her selected username and password like a normal
user.

Sample scenario

Assume we've already created an account via admin.unitedstreaming.com
(unitedstreaming.com/admin). At this point, the account administrator could go to
‘edit account’ under “account manager,” choose an account, and view the assigned
passcode on the account information page. This passcode can be distributed (by
phone, email, training, meeting, etc.) to any individual that is considered a
Department Head (School Building Administrator). When the user comes to the site
and enters this passcode, he/she will be prompted for his/her user information (see
above for a sample of what the user will be asked to enter). Additionally, the user
will be asked to select a “"School or Organization” from the list of departments that
already exists, or enter a new one. Upon completing the form and submitting it, the
user’s account is created. The user will be assigned “Department/School Admin”
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permissions, and the user may log into the website. The same procedure pertains to
any type of passcode you choose to distribute.

For example, click on a Department (i.e., a school) to view the “Teacher” passcode.
Click on a Teacher to view the “Student” passcode.

Passcode Types and how they are used
Here’s a breakdown of how each different type of passcode can be used for creating
user accounts.

Account Passcode
This passcode should be given to individuals who should be allowed to create their
own “Department Head (School Administrator)” user accounts.

e This passcode is assigned automatically when a new account is created and
can be viewed via the admin.unitedstreaming.com
(unitedstreaming.com/admin) site.

e This passcode will allow each user to either create a new department (i.e.,
School or Organization) or select from a list of departments that already exist
for the account to which the passcode is associated his/her.

Once the user has created their account, the user will receive TWO email messages
as follows:

e First email will contain a welcome message and a summary/reminder of the
user information he/she has entered.

e Second email will contain instructions for allowing Department Heads to
create his/her own department and user account.

Department/School Building Passcode
This passcode should be given to individuals allowed to create his/her own “Teacher”
user accounts.

e This passcode is assigned automatically when a new department is created
and can be viewed via the account manager by clicking on a department from
the list of departments on the right side of the page.

e This passcode will NOT allow the user to select a department (i.e., School or
Organization) themselves. Rather, the department will automatically default
to the one that corresponds to the passcode they have provided. In other
words, if a user provides the passcode for a department named “"Sample High
School,” then the “School or Organization” field will automatically display
“Sample High School,” not allowing the user to change the selection.

e This passcode will NOT allow the user to enter his/her “Title” in the user form.
Instead, title will automatically be defaulted to “Teacher.”

Once the user has created his/her account, the user will receive TWO email
messages as follows:

e First email will contain a welcome message and a summary/reminder of the
user information he/she has entered.
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e Second email will contain instructions for allowing the teacher’s students to
create his/her own user accounts. The second email is optional. The
unitedstreaming administrator may choose to block this feature.

Teacher Passcode
This passcode should be given by teachers to students who are allowed to create
his/her own “Student” user accounts.

e This passcode is assigned automatically when a teacher’s user account is
created and can be viewed via the account manager by selecting a
department from the list of departments on the right side of the page, then
selecting the user from the “Users” box on the right side of the page and
pressing the “Edit” button.

e This passcode will NOT allow the user to select a department (i.e., School or
Organization) themselves. Rather, the department will automatically default
to the one that corresponds to the passcode the user has provided. In other
words, if a user provides the passcode for a teacher from a department
named “Sample High School,” then the “School or Organization” field will
automatically display "Sample High School,” not allowing the user to change
the selection.

e This passcode will NOT allow the user to enter his/her “Title” in the user form.
Instead, title will automatically be defaulted to “Student.”

e This passcode will trigger the display of the name of the Teacher who owns
this passcode.

Once the user has created his/her account, the user will receive ONE email message
as follows:

¢ Email will contain a welcome message and a summary/reminder of the user
information he/she has entered.

e A SECOND email will be sent only to the teacher alerting them that this
particular student has created a user account. This email will also contain
instructions for allowing the parents of this particular student to create their
own user accounts.

Student Passcode
This passcode should be given to individuals allowed to create their own “Parent”
user accounts.

e This passcode is assigned automatically when a student’s user account is
created and can be viewed via the account manager by selecting from
departments on the right side of the page, then selecting the user from the
“Users” box on the right side of the page and pressing the “Edit” button.

e This passcode will NOT allow the user to select a department (i.e., School or
Organization) themselves. Rather, the department will automatically default
to the one that corresponds to the passcode they have provided. In other
words, if a user provides the passcode for a teacher from a department
named “Sample High School,” then the “School or Organization” field will
automatically display "Sample High School,” not allowing the user to change
the selection.

e This passcode will NOT allow the user to enter his/her “Title” in the user form.
Instead, title will automatically be defaulted to “Parent.”
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e This passcode will trigger the display of the name of the Teacher of the
Student that owns this passcode.

e This passcode will trigger the display of the name of the Student that owns
this passcode.

Once the user has created his/her account, the user will receive ONE email message
as follows:

¢ Email will contain a welcome message and a summary/reminder of the user
information he/she has entered.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Playlist

& PC - Click Icon to Print MAC - Select 'File - Print’
Bookmark video clips to your playlist for later retrieval!

Clicking the “a” button next to a video clip will allow you to add the clip to your
default playlist (My Playlist) or enable you to create a new one. Adding a video clip to
a playlist does not download or stream the clip. The purpose of the playlist is to
“bookmark” the clip so that you do not have to search for it again once you’ve found
it. It makes lesson planning easy! You can get to your Playlist Manager by clicking on
the “Playlist” link at the top of your screen. Here, all the clips are listed for your
default list.
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All available titles list.

Media Type Selection: Flayer Display Selection: P'|EL:-:.-"|iSTS j
Wy
v [ Q a Embedded % Standalone FPlaylist Mdanager

Dovwnload Instructions
Internet Explorer: Left Mouse click the "I button. ou will be prompted to save the media file. Choose the

loczation wou want the media file to be stored on your system.

Title Summary

KEY
(5

stream  download add to playlist
w E] Pumped-Up World of Pre-Algebra, The, Program 4: Basic Algebra ¢z5.00)

w El Introducing the Standard Deviants! o:1s)
M Bl Part Five: Inequalities (Continued fram Program 3) ¢15:38

m E Saction B: Pulting Inequalities on the Humberline (14:35)

Upon clicking “a,” a window will pop up asking you where to add the clip. You may
add clips to "my playlist,” which is the default, or choose to create a new playlist.
You may name the list anything you choose.

Add this clip to:
T My Playlist
* 4 new playlist: Algehra-graphing]

continue

Click continue and your clip will show up in the new playlist you've created (or
whichever you have chosen). If at any time you wish to remove this clip from your
playlist, click the “r” button. By clicking the dropdown box, you can exit your playlist
and go back to your last search results.

All available titles list.

hedia Type Selection: Plaver Display Selection: P|i3.‘_',-"|i5t5 j
ey
= Mg @ G w Embeddead L8 Standalone P|El'_',.-"|i5t5
by Flanglist

Dovwmload Instructions i
Internet Explorar: Laft Mouse click the "0" button. *fou will be prompted to save the medrd

location you want the media file to be stored on wour system.

Title Summary
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Image Library
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Web-based images from United Learning

We have hundreds of professionally photographed images, which are available to you
through unitedstreaming.

To Access Our Images:
Step 1: Select “Learning Resources” from the navigation bar.
Step 2: Click on “Image Library” on the left side of the window.

Step 3: You can search for images by keyword in the "SEARCH” field or scroll
through the entire library by clicking "NEXT".

Step 4: When you find the photo you are looking for select a resolution.
Thumbnail - the size displayed for selection.

Low Resolution - for reports.

High Resolution - for printing.

To download an image...
NOTE: You must use a photo viewer in order to view downloaded images.

PC Users:

Select an image to download. Hover your mouse over the desired resolution. Right
click to download: scroll down the pop-up menu and select (unclick on) "Save Target
As..." or "Save Link As..." (depending on which browser you are using). Change the
file name and save to a designated folder.

To view the image:

Step 1: Browse to where you saved the image.
Step 2: Double Click the image to launch your default viewer.

If your default viewer does not launch Select by Clicking START, Programs,
Accessories, Entertainment - Select “Paint” and then go to “File” and then “"Open”
the image from there.
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Macintosh Users:

Select an image to download. Hover your mouse over the desired resolution.
Control-Click and “Save file to disk.” You will see a pop-up screen that asks you to
save your image. You may give your image a different name, but also save the file
extension .jpg. Navigate to a folder to save your image.

To view the image:
Step 1: Navigate to the folder where you saved your image.

Step 2: Double Click the image to launch your default viewer.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved

Network Manager

& PC - Click Icon to Print MAC - Select 'File - Print'

The unitedstreaming Network Manager allows you to download videos overnight and
provide access to videos stored on your network through the unitedstreaming
interface.

Users of unitedstreaming will have the ability to select videos and schedule them to
be downloaded during off-peak Internet hours. An administrator of the Network
Manager schedules the time and days for the application to begin transferring videos.
For example, a teacher will select a video clip to be downloaded to the local server,
at 7pm the Network Manager will begin transferring the video, by the next day the
teacher will have the video available on the local server.

The Download Later button will appear just to the right of the download button.
Clicking on this button will schedule the video to be automatically downloaded to
your local server overnight.

0 0 s

Select o ddcoto ae down ocdzd by siromm  dowrlosd  doeriond baber okl b playiot
Gickng chths Dovwnload Lete . O = B} Amaricz in the 20th Cemuny: The Progressive Era oo
boftan a sold grev cire e =
w- Bl Tee Batn of the Procressies Bra pcss)
KEY
o a ]
SRR AYATENAN  HiYaC e IS Al T EaeT
OO0 5| B America in the 20th Cantury: The Progressive Cramogen T_h:I e .-ml e lu A ;rl:_ll LT EN (NI T
- _— Aitle ndizalicyg the wic el is
s ] The Bith of the Mrog-esane i o3 weilie. g v ooe d i load=d

The video will download overnight. The next day when revisiting unitedstreaming,
you will notice the Download Later button has changed into a green checkmark. This
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means the video is now available. Use the “s” and “d” buttons to stream or download
the video.

Once the video is downloaded, you will notice improved performance, including faster
response time and the ability to have multiple users access the video simultaneously.
Videos downloaded using this method will be available to all other unitedstreaming
users in your district.

REY

O ﬂ [w
lhe con willtar tC a grzeqchecsrak =l wam ouad  dserubsbls dd Ly plavdel
1 A e e - N 1 - - - - - - T
indizgtiag th= videal-as h"-': "I""'W'I'I"I:a""- I e m . ﬂ Punerica in the 206y Centurgz The Prograssive B scon
acil reaily troplay La=bw s ard 'l —
b ttons b steam worneealcar t- e viden SIE ho Bis o b Pragrozere Era @42

If you visit unitedstreaming and notice that the Download Later button has turned
red, your local server is offline and the video is not currently available. Please
contact your technology department to inform them of the issue.
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Any questions should be directed to support@unitedlearning.com or call
800.323.9084.

United Learning is a division of Discovery Communications.
Copyright ©2004 Discovery Communications Inc. All Rights Reserved
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